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ATTENTION 
  
It has come to VEMCO's attention that in rare instances it 
is possible for the USB interface chips in certain computers 
to experience permanent component failure when connected 
to a USB device. These failures, which may relate to electric 
static discharge damage, are not related to the specific USB 
device connected to the computer and have been reported to 
occur with cameras, scanners, printers, pocket PC 
handheld devices, and MP3 players.   
 
To reduce the risk of damage to the computer, some 
computer manufacturers have recommended connecting 
USB devices through a powered hub, rather than directly to 
the computer.  We have confirmed that the Dlink DUB-H4 
USB 2.0 powered hub will allow the VR100 to operate 
correctly.   
 
We hope this information is helpful. 
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1 INTRODUCTION 
 

1.1 ABOUT VEMCO 
 
VEMCO, a division of AMIRIX Systems Incorporated, is a leader in the design and manufacture of 
oceanographic research tools and systems since 1979. VEMCO's product line ranges from miniature 
acoustic transmitters and data loggers to large tracking, positioning, and monitoring systems. Data 
communication methods include acoustic telemetry, radio modem, and under-water modem. 
    
Please contact us at: 
   VEMCO, 
   77 Chain Lake Drive, 
   Halifax, Nova Scotia, 
   Canada  B3S 1E1 
 
   Phone: 902-450-1700 
   Fax: 902-450-1704 
   Web:  www.vemco.com 
 
 
 
1.2 SYSTEM REVIEW 
 
The VR100 is a general-purpose ultrasonic, splash-resistant, receiver designed for manual tracking of 
aquatic animals from small boats or for recording laboratory data.  Its hardware architecture has been 
developed to support a wide range of applications and transmitter types.  It replaces the VR60 receiver. 
 
The VR100 software augments the VR100 receiver by having the following features: sensor tag 
management, custom coded map management, data retrieval, and comma separated variable file creation.  
It can also store a copy of the receiver’s tag and map information on the computer, and that copy can be 
loaded to another VR100 or re-loaded to the current VR100 if necessary. 
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1.3 USING THIS MANUAL 
 
This manual, the VR100 Software Manual, contains the necessary information to use the VR100 software 
with the VR100 receiver to input sensor transmitter information and retrieve event data.  Event data can 
be data about a tag detection, GPS locations, and functions performed by the VR100.  The receiver can be 
used as a stand-alone unit (without software) and the necessary details are contained in the VR100 
Operating manual.  Using the VR100 software with the receiver allows information to be entered and 
retrieved in a much faster manner. 
 
This manual is broken into major sections for easier use of the information found in the manual.  These 
sections, and a brief explanation, are listed in Table 1.3-1. 
 
 

Table 1.3-1:  Sections contained in this manual. 
Section Description 

Introduction Introduction to the VR100 and this manual. 
Applications Details on how to use the VR100 software with the receiver. 

Software Description of the software elements.  
File Types Information on log files, CSV files, and resource files. 
Appendix Glossary and additional information. 

 
 
The manual refers to tags, pingers, and sensor transmitters.  The relationship these three terms have with 
each other is shown in the diagram below.  A tag can be either a pinger or a sensor transmitter. 
 
 
 
 
 
 
 
 
 
 
 
 

TAG

PINGER 
These are tags that do not contain a 
sensor and don’t transmit data information.
 
Pinger information is not entered in the 
receiver. 

SENSOR TRANSMITTER 
These are tags that contain at least one 
sensor.  They transmit the sensor data. 
 
Sensor transmitter information must be 
entered in the receiver. 
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2 APPLICATIONS 
 
This section of the manual explains the VR100 software by tasks.  The Software section of the manual 
explains the software by section. 
 
2.1 QUICK SETUP 
 
Follow the steps listed below to setup the VR100 software and begin using it with the VR100 receiver. 
 
1. Connect VR100 to computer: 

a. Install the VR100 software on the computer, if not already installed (see section 5.1.2). 
b. Run the VR100 software.  This will open the Receiver Control and Management Interface 

window (see section 3.1). 
c. Connect the VR100 to the computer using the supplied USB cable (see the VR100 hardware 

manual for details).  
d. Turn on the VR100.  If you are using Windows©2000, Windows©XP, or Windows©Vista, a 

“new hardware” wizard will appear the first time a VR100 is connected to the computer.  Follow 
the instructions in the wizard to add the VR100. 

2. Open a VR100 window: 
a. Verify that the desired receiver is highlighted in the Receiver Control and Management Interface 

window (see section 3.1).  If you can’t find the receiver in the list, then make sure the receiver is 
on and that the USB connector is properly connected. 

b. Click the “Open” button in the Receiver Control and Management Interface window to open the 
VR100 Receiver window for the selected receiver (see section 3.2). 

3. Set properties in software:  (only needs to be done on first use and if information has changed) 
a. Open the Options window (see section 3.2.3.2) in the Setting menu. 
b. Select the units to be used for the sensor information (see section 3.2.3.2). 
c. Select the data directory to be used for the raw events files (see section 3.2.3.2). 

4. Enter sensor transmitter information and custom coded maps (if needed): 
a. Open the Tag Manager window (see section 3.3). 
b. Setup the sensor transmitters being used with the receiver (see section 3.3.2.1.1). 
c. Setup any needed custom coded maps (see section 3.3.2.1.2).  Most customers will never need a 

custom coded map.  Custom coded maps are used with custom coded tags.  
5. Transfer the sensor transmitter and custom coded map (if applicable) information to the VR100 

receiver (see section 2.2.10). 
6. Turn off the VR100 receiver. 
7. Disconnect the VR100 receiver from the computer. 
8. Use the receiver in the field as explained in the VR100 Hardware manual. 
9. Repeat steps 1 and 2. 
10. Copy the collected data to the computer using Get All Data (see section 3.2.2.1). 
11. Save the data as a Comma Separated Variable file (.csv) for viewing in a spreadsheet program (see 

section 3.2.1.2). 
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2.2 HOW DO I … 
 
The “How Do I …” section of the manual lists the steps necessary to perform particular actions in the 
VR100 software.  The actions are listed alphabetically for easier referencing.  Use the Quick Setup 
(section 2.1) to use the VR100 software in a step-by-step manner.  
 
2.2.1 Add a coded sensor transmitter 
 
Follow the steps listed below to enter a coded sensor transmitter in the VR100 software (see section 
3.3.2.1.1). 
 
From the VR100 Receiver window (see section 3.2): 
 
1. Open the Tag Manager window by selecting Tag Manager in the Settings menu. 
2. Open a resource file, if desired (see section 2.2.9). 
3. Click the “Coded256Sensor” located in PC Managed Setup (left side of window).  The Add Coded 

256 Sensor section will appear in the bottom left corner of the Tag Manager window. 
4. Enter the following information in the correct boxes.  The boxes are labelled and the information is 

found in the Transmitter Specification manual shipped with the sensor transmitter. 
a. Serial number 
b. Frequency in kilohertz (kHz) 
c. ID number 
d. Code Space – select the correct one from the pull-down list.  
e. Sensor type – temperature or depth 
f. Slope 
g. Intercept 

5. Verify that the information was entered correctly. 
6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC 

Managed Setup section of the window. 
7. Transfer the tag setup to the VR100 receiver (see section 2.2.10).   
 
2.2.2 Add a continuous one sensor transmitter 
 
Follow the steps listed below to enter a one sensor transmitter in the VR100 software (see section 
3.3.2.1.1). 
 
From the VR100 Receiver window (see section 3.2): 
 
1. Open the Tag Manager window by selecting Tag Manager in the Settings menu. 
2. Open a resource file, if desired (see section 2.2.9). 
3. Click the “ContinuousOneSensor” located in PC Managed Setup (left side of window).  The Add 

Continuous Sensor section will appear in the bottom left corner of the Tag Manager window. 
4. Enter the following information in the correct boxes.  The boxes are labelled and the information is 

found in the Transmitter Specification manual shipped with the sensor transmitter. 
a. Serial number 
b. Frequency in kilohertz (kHz) 
c. Number of sensors – One 
d. Minimum period possible, in milliseconds (ms) 
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e. Maximum period possible, in milliseconds (ms) 
f. Sensor type –  temperature or depth 
g. Slope 
h. Intercept 

5. Verify that the information was entered correctly. 
6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC 

Managed Setup section of the window. 
7. Transfer the tag setup to the VR100 receiver (see section 2.2.10).   
 
2.2.3 Add a continuous two sensor transmitter 
 
Follow the steps listed below to enter a two sensor transmitter in the VR100 software (see section 
3.3.2.1.1). 
 
From the VR100 Receiver window (see section 3.2): 
 
1. Open the Tag Manager window by selecting Tag Manager in the Settings menu. 
2. Open a resource file, if desired (see section 2.2.9). 
3. Click the “ContinuousTwoSensor” located in PC Managed Setup (left side of window).  The Add 

Continuous Sensor section will appear in the bottom left corner of the Tag Manager window. 
4. Enter the following information in the correct boxes.  The boxes are labelled and the information is 

found in the Transmitter Specification manual shipped with the sensor transmitter. 
a. Serial number 
b. Frequency in kilohertz (kHz) 
c. Number of sensors – Two 
d. Minimum period possible in milliseconds (ms) 
e. Maximum period possible in milliseconds (ms) 
f. In Sensor Details, click “Sensor One” 
g. Sensor type – usually temperature 
h. Slope 
i. Intercept 
j. In Sensor Details, click “Sensor Two” 
k. Sensor type – usually pressure 
l. Slope 
m. Intercept 
n. Sync – default value is 1150 ms 

5. Verify that the information was entered correctly. 
6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC 

Managed Setup section of the window. 
7. Transfer the tag setup to the VR100 receiver (see section 2.2.10). 
 
2.2.4 Create a comma delimited file from data  
 
Create a comma delimited file from data by following the steps below (see section 3.2.1.3). 
 
1. Open the VR100 Receiver window (see section 3.1.1) for the receiver containing the data. 
2. Select Get All Data (see section 3.2.2.1) or Get Recent Data (see section 3.2.2.2), depending on how 

much data you want.  The data will load to the computer in less than four minutes. 
3. When prompted, select “Yes” to erase the receiver log data that was just copied to the computer or 

select “No” leave the log in the receiver. 
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4. Select Export in the File menu (see section 3.2.1.3). 
5. Enter the desired file name in the “File name” box of the Export Current Log window and click 

“Save”.  The comma delimited file is created and located in the directory selected. 
 
The comma delimited file, or Comma Separated Variables file (see section 4.2), is now ready to be 
opened using a .csv supporting spreadsheet program of your choice.  Examples of spreadsheet programs 
that will support a .csv file are Excel and Quattro Pro. 
 
2.2.5 Create a comma delimitated file from a log file 
 
Create a comma delimited file from a log file by following the steps below (see section 3.2.1.2). 
 
1. Open a VR100 Receiver window (see section 3.1.1).  This can be any receiver window, including the 

Virtual receiver. 
2. Open the desired log file (see section 3.2.1.1). 
3. Select Export in the File menu (see section 3.2.1.3). 
4. Enter the desired file name in the “File name” box of the Export Current Log window and click 

“Save”.  The comma delimited file is created and located in the directory selected. 
 
The comma delimited file, or Comma Separated Variables file (see section 4.2), is now ready to be 
opened using a .csv supporting spreadsheet program of your choice.  Examples of spreadsheet programs 
that will support a .csv file are Excel and Quattro Pro. 
 
2.2.6 Edit a sensor transmitter 
 
Sensor transmitters that have already been entered can be edited.  Follow the steps below to edit an 
existing sensor transmitter (see section 3.3.2.1.1). 
 
1. Highlight the desired tag in the PC Managed Setup list (left side of Tag Manager window).  The 

information already entered about that tag is displayed in the bottom left corner of the window but is 
not accessible for editing. 

2. Click the “Edit” box in the bottom left corner of the window. 
3. Edit the tag information as needed. 
4. Click the Update button. 
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2.2.7 Load data from VR100 
 
Data that has been received and stored in the VR100 receiver can be loaded to the computer (see section 
3.2.2). 
 
1. Open the VR100 Receiver window (see section 3.1.1) for the receiver containing the data. 
2. Select Get All Data (see section 3.2.2.1) or Get Recent Data (see section 3.2.2.2), depending on how 

much data you want.  The data will load to the computer in less than four minutes. 
3. When prompted, select “Yes” to erase the receiver log data that was just copied to the computer or 

select “No” leave the log in the receiver. 
 
2.2.8 Load the receiver’s setup to the computer 
 
The sensor tags and coded maps setup in the receiver are listed in the Receiver Setup half of the Tag 
Manager window (right side).  This list is updated automatically, but can be manually updated by 
following the steps listed below. 
 
1. Open the Tag Manager window (see section 3.3). 
2. Select Refresh in the Receiver Setup menu. 
 
2.2.9 Open a Resource file 
 
Open a resource file (see section 4.3) to retrieve the sensor tag setups and the custom coded map setups (if 
applicable).  A resource file is opened by following the steps below while in the VR100 Receiver window. 
 
1. Select Tag Manager in the Settings menu of the VR100 Receiver window (see section 3.2). 
2. Select Open in the File menu of the Tag Manager window (see section 3.3). 
3. Select the desired file in the Open window.  It may be necessary to move to a different directory, 

depending on where the resource file was saved. 
4. Click the “Open” button or double click the file name.   
 
When a resource file is open, the sensor tag setups and custom coded map setups contained in that file are 
shown in the PC Managed Setup half (left side) of the Tag Manager window. 
 
2.2.10 Transfer the PC Managed Setup list to the Receiver Setup list 
 
The tag information entered in the PC Managed Setup half of the Tag Manager window (see section 3.3) 
must be transferred to the Receiver Setup half of the window to be downloaded to the VR100 receiver.  
Follow the steps listed below to perform such a transfer. 
 
1. Open the Tag Manager window (see section 3.3). 
2. Enter the tag information by either entering it in the window (see section 3.3.2.1.1) or by opening a 

previously saved resource file (see section 3.3.1.2). 
3. Select the desired tag in the PC Managed Setup list (left half of window) by clicking it once with the 

mouse. 
TIP:  To select more than one tag at once, select the first tag then hold the Control key on the 
computer’s keyboard while you select the other tags with the mouse arrow.  Press the Shift key 
instead to select blocks of tags.  
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4. Click the right-pointing arrow located in the middle of the Tag Manager window.  The selected tag 
setup is transferred to the Receiver Setup list (right half of window) and automatically transferred to 
the VR100. 

 
2.2.11 View a comma delimited file 
 
Comma Separated Variable files (.csv), also known as Comma Delimited Files, can be viewed using any 
spreadsheet program that supports .csv files.  For example, Microsoft Excel and Corel Quattro Pro are 
both programs that support .csv files. 
 
2.2.12 View a log file 
 
Log files contain data received by the VR100 receiver (see section 4.1 for more information).  Log files 
can not be edited but can be viewed by following the steps listed below. 
 
1. Open a VR100 Receiver window.  It doesn’t matter which receiver is selected, including the Virtual 

receiver. 
2. Select “Open” in the File menu of the VR100 Receiver window (see section 3.2.1.1). 
3. Select the log file from the list shown in the Open window.  The Open window will automatically list 

all log files located in the directory selected for Raw Event Logs (see section 3.2.3.2). 
 
The log file is displayed in the VR100 Receiver window, as shown in section 4.1.  Comments added to the 
“comments” column of the file are saved when the log file is saved as a comma delimited file (see section 
3.2.1.2).  No changes can be made to the log file in .zlog format. 
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3 SOFTWARE 
 
 
This section of the manual explains the VR100 software by section.  The Application section of the 
manual explains the software by tasks.  The software has three main sections: Receiver Control and 
Management Interface, VR100 Receiver, and Tag Manager. 
 
 
3.1 RECEIVER CONTROL AND MANAGEMENT INTERFACE 
 
VR100 receivers that are currently powered and connected to the VR100 software through a USB port are 
listed in the Receiver Control and Management Interface window, shown below.  More than one receiver 
can be connected to the software through the computer’s USB connection at the same time.  A USB hub 
increases the number of connections available for receivers.  The receiver that was most recently 
connected to the software is highlighted in blue in the VR100 list (see picture below).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The VR100 software can be used without a VR100 being connected to the computer by selecting the 
serial number “Virtual”.  This allows sensor transmitter information and coded map setups to be entered 
without the receiver being physically connected.  This allows sensor tag setups to be entered and saved in 
the software (see section 3.3) while the receiver is being used elsewhere. 
 
3.1.1 Open a VR100 Receiver window 
 
The quickest method to open a VR100 Receiver window (see section 3.2) is to double-click the desired 
receiver’s serial number in the list.  A receiver window can also be opened by highlighting the desired 
serial number and clicking the “Open” button at the bottom of the window.   
 
 
 



VEMCO – VR100 Software Manual – Page 10 

3.2 VR100 RECEIVER 
 
When a receiver is opened from within the Receiver Control and Management Interface window (see 
section 3.1), it opens a VR100 Receiver window like the one shown below.  The receiver’s serial number 
is displayed in the top left corner to identify which receiver is associated with this window.   
 
When more than one receiver is open, then more than one VR100 Receiver window is open.  One VR100 
Receiver window is assigned to each receiver opened in the Receiver Control and Management Interface 
window.  Commands performed in the VR100 Receiver window affect only the receiver associated with 
that window. 
 

 
When data has been loaded from the receiver to the computer (see section 3.2.2), the number of system 
events and the number of detections in the loaded data are displayed the VR100 Receiver window.  The 
date and time of the latest detection or system event is also displayed.   
 
Selecting the “Clear Table” button in the VR100 Receiver window will clear the log file displayed in the 
VR100 Receiver window without clearing the log file (see section 4.1 for more information on log files).  
Clicking the “Abort” button will stop the data loading process (see section 3.2.2). 
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3.2.1 File 
 
The File menu in the VR100 Receiver window is separate from the File menu in the Tag Manager 
window (see section 3.3.1). 
 
3.2.1.1 Open 
 
The Open command in the VR100 Receiver window allows a log file (see section 4.1) to be opened and 
viewed in the VR100 Receiver window.  Log files are saved when the Save As… command is used (see 
section 3.2.1.2).  A log file can be opened within any VR100 Receiver window, including the Virtual 
VR100 Receiver window. 
 
3.2.1.2 Save As… 
 
The data retrieved from the VR100 receiver can be saved as a ZLOG file (see section 4.1).  The Save As… 
feature opens the Save Current Log As window to allow the log file to be named.  The file is saved with 
the “.zlog” extension to distinguish it as a log file. 
 
3.2.1.3 Export 
 
The data retrieved from the VR100 receiver can be exported as a CSV file (see section 4.2).  The Export 
feature opens the Export Current Log window to allow the comma delimited file to be named.  The file is 
saved with the “.csv” extension to distinguish it as a Comma Separated Variables file. 
 
3.2.1.4 Exit 
 
This Exit command closes the VR100 Receiver window but not the Receiver Control and Management 
Interface window.  This allows another receiver to be selected in the Receiver Control and Management 
Interface window. 
 
 
3.2.2 Logs 
 
The Logs menu is used to load, or copy, the data stored on the VR100 receiver to a log file on the 
computer.  There are two options in loading data, to retrieve all the data stored in the VR100 (Get All 
Data) or to retrieve the data stored since the last upload (Get Recent Data).  
 
When data is loaded to the computer, it’s actually copied to the computer.  The original copy is still in the 
receiver’s memory.  After the data is loaded to the computer, a prompt appears to ask if the data in the 
receiver’s memory, which was just copied to the computer, should be erased.  Selecting “Yes” will erase 
the retrieved data from the receiver’s memory.  Any new data that was recorded while the previous data 
was being loaded to the computer is still in the receiver’s memory. 
 
3.2.2.1 Get All Data 
 
The Get All Data command loads all data from the VR100 receiver to the computer.  This could take up 
to four minutes, depending on how much information is stored in the receiver’s memory.  The loaded data 
is stored as a log file (see section 4.1). 
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3.2.2.2 Get Recent Data 
 
The Get Recent Data command loads any new data stored in the VR100 receiver since the last command 
was given to load data.  If the Get All Data has never been given to this receiver, or if a different 
computer is being used since the last Get Recent Data command, then the computer will get all the stored 
data.   
 
NOTE:  The method used to mark which data has been loaded to the computer is stored on the computer.  

If the Get Recent Data command is sent from a different computer, then the computer doesn’t 
have a record of a previous upload and will load all the data from theVR100. 

 
3.2.2.3 Erase VR100 Log 
 
The Erase VR100 Log command will erase the event log in the VR100 receiver.  This is the same 
command that is seen after data is loaded from the receiver to the computer (see section 3.2.2). 
 
When the command is given, a verification screen 
is displayed to confirm that the receiver’s log 
should be erased.  The screen also indicates that 
some of the stored data may not have been loaded 
to the PC.  This is a reminder to upload the data 
from the VR100, if you want to keep the data, 
before erasing the memory.   
 
To continue, click the “Yes, Erase the log” box and 
then the Erase button.  The Erase button isn’t enabled until the Yes box is checked.  
 
When the memory is being erased, the Information window shown below is displayed on the screen to 
indicate the erase command is being executed.  It also indicates that some residual data may be retained in 
the receiver’s memory. 
 
Data is initially stored in a small, volatile memory buffer.  When the buffer is full, that data is moved to 
non-volatile long-term memory.  The Erase VR100 Log command erases all data in the long-term 
memory but not data in the buffer memory.  This feature allows the VR100 to continue to record new data 
during the erase process.   
 
The data in the buffer, which is the most recent data, continues to be stored until the buffer is full and is 
then moved to the long-term memory.  This means that the data in the buffer will be loaded to the 
computer with the next upload and may appear as duplicated data.  This can be avoided by using the Get 
Recent Data command (see section 3.2.2.2). 
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3.2.3 Settings 
 
The Settings menu contains the sub-menus Tag Manager, Options, and Update VR100 Firmware. 
 
3.2.3.1 Tag Manager 
 
The Tag Manager window allows sensor tag setups to be created or edited, and transferred to VR100 
receiver.  A group of sensor tags can be saved as a setup file and opened at a future time.  The Tag 
Manager window is explained in detail in section 3.3. 
 
3.2.3.2 Options… 
 
There are three options that are set in the Options window, 
shown here.  Two of these options are the units used for 
temperature and depth data.  These units are universal for the 
receiver.  For example, if °C is selected for temperature units, 
then all the temperature data received by the VR100 is in 
degrees Celsius (°C).   
 
VEMCO’s standard units are °C and metres.  Other units can be 
used but the slope and intercept values must be converted to the 
new units and entered in the VR100.  The VR100 doesn’t 
automatically convert units. 
 
The Raw Event Logs directory is also selected in the Options 
window.  When data is loaded from the VR100 to the computer 
using the Logs menu (see section 3.2.2), raw log files (see 
section 4.1) are stored in the location selected here. 
 
3.2.3.3 Update VR100 Firmware… 
 
The firmware operating inside the VR100 can be updated without having to send the receiver to the 
factory.  The firmware is updated in three steps, which are listed and explained below.  To update the 
firmware, simply follow the directions of the computer screen. 
 
Step 1:  Current configuration.  The current configuration of the VR100 receiver is checked and displayed 

in the Update Firmware window on the computer screen. 
Step 2:  Select Image file.  Use the “Browse” button to identify the new firmware file on your computer.  

The “Select Image File” window will automatically open the directory selected for Raw Event 
Logs in the Options window (see section 3.2.3.2) and only files with the correct extension will be 
shown. 

Step 3:  Test File.  The VR100 software tests the new firmware file before it is loaded to the VR100 
receiver.  It will then send the file to the receiver. 
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3.2.4 Help 
 
The Help menu contains the sub-menus described below for your assistance. 
 
3.2.4.1 Content and Index 
 
The Content and Index command opens the Help Topics window to allow access to help information.  
The Help Topics window contains the tabs Contents, Index, and Find which are explained below. 
 
 Contents 
 
To select a general topic for overall help, use the Contents feature.  Open a topic by double clicking on 
the book symbol next to the name, or on the name itself.  A list of sub-topics will appear to choose from. 
Double clicking on one of these sub-topics will open the help topics related to that general topic. 
 
 Index 
 
To select a specific topic, use the Index feature, which will display the complete list of topics in the help 
file.  To select a topic, either move through the list (using the arrow keys or the scroll bar) until the 
desired topic is highlighted, or type the name in the box at the top of the window.  As the name is entered, 
the list will reflect the letter being entered.  For example, if the letter “t” is entered, the list will alter so 
the “t” section is shown.  Once the topic is highlighted, either select Display at the bottom of the window, 
or double click on the topic name. 
 
 Find 
 
To search for a specific word within a topic use the Find feature.  A word list must be created if Find has 
not been previously used.  Simply follow the on-screen instructions to setup Find.  If Find is not desired, 
select Cancel.  A list of topics containing the desired word is listed in the third box from the top.  Select a 
topic and click the Display button at the bottom of the window. 
 
 
3.2.4.2 About VR100… 
 
Information about the VR100 associated with the selected VR100 Receiver window is shown in the 
Information window.  This information includes the serial number of the receiver and its hardware 
version, and firmware version.  If the VR100 was disconnected from the computer after the VR100 
Receiver window was opened, then the About VR100… feature reports that the VR100 is disconnected. 
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3.3 TAG MANAGER 
 
The Tag Manager window is the place to enter or edit sensor transmitter information.  It’s opened by 
selecting Tag Manager in the Settings menu of the VR100 Receiver window.  How to add or edit 
information is explained in section 3.3.2.   
 
The left half of the Tag Manager window is called the PC Managed Setup and is used to enter and edit 
sensor tags.  The information seen in the PC Managed Setup list is the tag/map setup contained in the PC 
software.  The right half of the window is called the Receiver Setup and is the actual tag/map setup 
contained in the VR100 receiver.  When the Tag Manager window is opened, the software automatically 
requests the current setup from the receiver and displays it in the Receiver Setup half of the Tag Manager 
window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The setup for tags can be passed between the PC and the receiver by using the arrow buttons in the middle 
of the window.  To copy a sensor transmitter from the PC Managed Setup list (on the left) to the Receiver 
Setup (on the right), select the desired tag by clicking it once with the mouse and then click the right 
pointing arrow in the middle of the window.  The tag now also appears on the right half of the window 
and has been automatically sent to the VR100.   
 
TIP: To select more than one tag at once, select the first tag then hold the Control key on the 

computer’s keyboard while you select the other tags with the mouse arrow.  Press the Shift key 
instead to select blocks of tags. 
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3.3.1 File 
 
The File menu in the Tag Manager window is separate from the File menu in the VR100 Receiver 
window (see section 3.2.1) and contains the sub-menus described below. 
 
3.3.1.1 New 
 
The New command clears the PC Managed Setup (left half of window) to allow a new setup to be 
entered.  If changes had been made and not saved when the New command is given, a prompt appears 
asking if the changes are to be saved before the settings are cleared. 
 
3.3.1.2 Open 
 
The Open command in the Tag Manager window allows a previously saved resource file to be opened 
(see section 4.3 for more information on resource files).  Only the resource files located in the directory 
are displayed in the Open window to make file identification simpler.   
 
3.3.1.3 Save 
 
The Save command allows changes made to a resource file to be saved.  What a resource file is named is 
determined by the user, but the extension must remain .xres or the file can’t be read by the software. 
 
3.3.1.4 Save As… 
 
The Save As… command allows the resource file name or location to be changed.   
 
3.3.1.5 Exit 
 
This Exit command closes the Tag Manager window but won’t close the VR100 Receiver window or the 
Receiver Control and Management Interface window.  This is the same as clicking the X in the top right 
corner of the window. 
 
 
3.3.2 PC Setup 
 
The PC Setup menu allows sensor transmitter information to be setup.  It’s also used to combine separate 
resource files. 
 
3.3.2.1 Add 
 
The Add sub-menu allows a sensor tag to be added.  Adding a tag refers to entering a sensor transmitter’s 
information so the received data can be displayed in the correct units, which must be done for each sensor 
transmitter being used with the VR100.   
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3.3.2.1.1 Add Tag 
 
A sensor transmitter’s information must be entered in the VR100 for the data to be displayed correctly.  A 
new sensor transmitter can be added by following the steps listed below. 
 
1. Select the tag type (coded 256 sensor, continuous one sensor, or continuous two sensor) by either 

using the PC Setup menu or by clicking the desired sensor type in the PC Managed Setup on the left 
half of the screen.  In either case, the bottom left corner of the Tag Manager window will display data 
entry boxes similar to the two samples shown below.  Initially the boxes are empty, as seen in the 
sample window on the left.  The sample window on the right has the information entered and is ready 
for the Update button to be clicked. 

 
 
 
 
 
 
 
 
 
 
 
 
 
2. Enter the information as identified in the window (see example above on the right).  The information 

needed is listed below by tag type.  The information can be found in the Transmitter Specification 
manual shipped with the sensor transmitters. 

 
a. Coded 256 Sensor: 

i. Serial number 
ii. Frequency in kilohertz (kHz) 

iii. ID number 
iv. Code Space – select from the pull-down list 
v. Sensor type – temperature or depth 

vi. Slope 
vii. Intercept 

 
b. Continuous One Sensor: 

i. Serial number 
ii. Frequency in kilohertz (kHz) 

iii. Number of sensors – One 
iv. Minimum period possible, in milliseconds (ms) 
v. Maximum period possible, in milliseconds (ms) 

vi. Sensor type –  temperature or depth 
vii. Slope 

viii. Intercept 

NOTE 
Only tags with 
sensors need 
to be entered 
in the receiver.  
Pingers don’t 
need to be 
entered.
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c. Continuous Two Sensor: 

i. Serial number 
ii. Frequency in kilohertz 

iii. Number of sensors (Two) 
iv. Minimum period possible in milliseconds 
v. Maximum period possible in milliseconds 

vi. In Sensor Details, click “Sensor One” 
vii. Sensor type (temperature) 

viii. Slope 
ix. Intercept 
x. In Sensor Details, click “Sensor Two” 

xi. Sensor type (pressure) 
xii. Slope 

xiii. Intercept 
xiv. Sync 

 
3. Click the Update button.  The tag is now added to the list shown in the PC Managed Setup half of the 

window (on left). 
 
NOTE:  The tag just setup has not yet been entered in the VR100 receiver.  It must be transferred to the 

Receiver Setup list (see section 2.2.10). 
 
Sensor transmitters that have already been entered can be edited.  Follow the steps below to edit an 
existing sensor transmitter. 
 
1. Highlight the desired tag in the PC Managed Setup list (left side of Tag Manager window).  The 

information already entered is displayed in the bottom left corner of the window but is not accessible 
for editing. 

2. Click the “Edit” box in the bottom left corner of the window to allow access to the information. 
3. Edit the tag information as needed and click the Update button. 
 
 
3.3.2.1.2 Add Map 
 
Maps are added by importing a .xres file.  Instructions for importing this file to your VR100 are found at 
http://www.vemco.com/pdf/vr100_codemap_instruction.pdf. 
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3.3.2.2 Import 
 
The import feature in the Tag Manager window allows multiple resource files to be combined into one 
file.  Follow the steps listed below to merge resource files. 
 
1. Open one of the files to be merged (see 3.3.1.2). 
2. Select Import from the PC Setup menu in the Tag Manager window.  The Import window will open. 
3. Select the second resource file to be merged and click the “Open” button. 
4. Repeat steps 2 and 3 until all the desired resource files are merged. 
5. If desired, save the merged file using the Save As… feature (see section 3.3.1.4) 
 
The merged file will not contain any duplication of information.  For example, if the sensor transmitter 
with the serial number 6739 is setup in two different resource files, it will only appear in the merged file 
once. 
 
 
3.3.3 Receiver Setup 
 
3.3.3.1 Refresh 
 
The Refresh command retrieves the current setup (sensor tags and maps) from the receiver and displays 
that setup in the right side of the Tag Manager window (called Receiver Setup).  The Refresh command is 
automatically executed each time the Tag Manager window is opened. 
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4 FILE TYPES 
 
4.1 LOG FILES 
 
Log files are saved when the Save As… command is used (see section 3.2.1.2).  The Open command in 
the VR100 Receiver window allows a log file to be opened and viewed in the VR100 Receiver window.  A 
log file can be opened within any VR100 Receiver window, including the Virtual VR100 Receiver 
window, but can only be viewed in the VR100 software.  The log file has been specifically designed so it 
can only be opened in the VR100 software. 
 
The log files are usually saved using a standard file naming system and with the extension .zlog but a 
unique name can be assigned when the file is saved.  A sample of the standard file name is shown below.  
The serial number in the file name is the serial number of the receiver the data was loaded from, and the 
date and time are when the log file was created on your computer.   
 
 
 
 
 
 
The data displayed in the log file contains the following information for tag detections:  date, local time, 
channel, frequency (in kHz), tag type, ID (if coded), serial number (sensor tags only), data (see section 
4.1.1), latitude, and longitude.  The signal strength and receiver gain levels can be viewed by “hovering” 
the mouse arrow over the cell in the Channel column.  Likewise, the slope(s) and interval(s) can been 
viewed by “hovering” the mouse over Data1 or Data2.  Comments can be typed in the Comments column 
of the log file to be saved in the Comma Separated Variable file (see section 4.2). 
 
Manual GPS readings are identified in the Type column of the log file as “GPS” and columns that don’t 
relate, such as frequency and data, are blank. 

 
 
Log files can be converted to Comma Separated Variable (.csv) files using the Export command in the 
VR100 Receiver window (see section 3.2.1.3). 

VR100_007493_D2005.01.20T14.09.42.zlog
             123     14243   123 
                Serial            Date             Time 
   Number 
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4.1.1 Data in Log files 
 
The sensor data is listed in either the “Data1” column or the “Data2” column of the log file.  If there is 
only one sensor in the sensor transmitter then data is only shown in the “Data1” column.  The unit for the 
data is given in the adjoining “Units” column.  The slope and intercept associated with this data can be 
viewed by holding the mouse arrow over the Data column.  The slope and intercept will appear for a few 
seconds in a small view box. 
 
Continuous pingers without a sensor display the period in the “Data1” column with the units listed as 
“ms” (milliseconds). 
 
 
4.2 COMMA SEPARATED VARIABLE FILES 
 
A Comma Separated Variable (CSV) file is a data file in which the variables are separated by commas.  
This allows the file to be opened in a spreadsheet package that is CSV compatible, such as Excel or 
Quattro Pro.  These files are created using the Export command (see section 3.2.1.3). 

 
NOTE: Starting in version 1.6.3 of the VR100HS, detection times are output to the CSV file with three 

extra digits of precision.  These value are correctly read by Excel, however the default display 
formatting (mm:ss.0) is incorrect.  Change the formatting to "hh:mm:ss.000" to properly display 
these times. 

 
 
4.3 RESOURCE FILES 
 
Resource files, which have the extension .xres, contain the setup information for the sensor transmitters 
and custom coded maps that have been entered in the software.  These files must be manually saved (see 
section 3.3.1.3) as they aren’t automatically created by the software.  Resource files are extremely 
beneficial because they eliminate the need to manually re-enter the sensor transmitter information.  This 
saves time and allows the information to be loaded to other VR100 receivers very quickly and easily. 
 



VEMCO – VR100 Software Manual – Page 22 

 
4.4 RAW FILES 
 
RAW files are automatically saved in the Raw Data Directory (see section 3.2.3.2) when data is loaded 
from the VR100 receiver.  These files, named VRDxxx.zraw where each x represents an integer, are not 
user-readable and are solely used by VEMCO for diagnostic or data recovery purposes.  The raw files can 
be deleted without affecting the operation of the VR100 if disk space is required on the computer but 
deletion is not necessary.  It’s suggested that the files are not erased until after data has been successfully 
recorded. 
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5 APPENDICES 
 
 
5.1 SOFTWARE 
 
5.1.1 System Requirements 
 
The VR100 software is a Windows©98SE/2000/XP/Vista based software application that can be executed 
on any IBM compatible personal or mobile computer with the following configuration: 
 

Minimum Pentium II Processor, 366MHz  
Minimum 4 MB Video RAM 
128 MB RAM 
Minimum SVGA Monitor 256 Colour 
CD drive for program installation 
One USB 1.1 or 2.0 connection (required for connection to VR100 receiver) 

 
 
5.1.2 Software Installation 
 
The VR100 software is a Windows©98SE/2000/XP/Vista application.  VEMCO assumes customer 
familiarity with Windows terminology.  
 
To install the VR100 software, follow the steps listed below. 
 

1. Insert the install compact disk (CD) into the CD drive. 
2. From the Start menu in Windows, select Run. 
3. Type “X:\VR100HS_2.1.0_setup.exe” where the “X” represents the letter associated with your 

CD drive.  
4. Follow the on-screen instructions. 
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5.2 CODED MAPS 
 
There are three default coded maps used with VEMCO coded tags.  These maps are listed in Table 5.2-1 
with their Code Spaces and submaps. 
 

TABLE 5.2-1:  Current VEMCO Coded Maps and submaps with Code Spaces. 

Map Name Code Spaces1 Blanking 
Interval Submap Description 

A69-1008 A R256 
A69-1206 B R04K 
A69-1105 C S256 

MAP-110 

A69-1303 

240 ms 

D R64K 
A69-1303 A R64K 
A69-1206 B R04K 
A69-1105 C S256 

MAP-210 

A69-1204 

240 ms 

D R04K 
A69-1107 A S256 
A69-1206 B R04K 
A69-1105 C S256 

MAP-310 

A69-1303 

240 ms 

D R64K 
 
 
IMPORTANT:  VEMCO tag datasheets will contain a Code Space name which fully defines the tag 

parameters necessary for the receiver. Ensure that your tags have a code space listed in the 
selected code map. 

 

                                 
1 Code Space is new nomenclature for VEMCO tag types. It has been introduced to remove ambiguity over tag 
parameters. VEMCO tag datasheets will contain a code space name. 
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5.3 TROUBLESHOOTING 
 

PROBLEM POSSIBLE SOLUTION 
I connected my VR100 to the computer with the 
VR100HS software but my VR100 isn’t listed in 
the Receiver Control and Management Interface 
window. 

If you received your VR100 after March 2006, 
either new or upgraded, then you must use 
VR100HS software version 2.0 or higher for the 
software to communicate with the VR100. 

I connected my VR100 to the computer with the 
VR100HS software but I get a message saying the 
software is not compatible. 

If you received your VR100 before March 2006 
and it hasn’t been upgraded, then the VR100HS 
software version 2.0 or higher won’t be able to 
communicate with the receiver.  An older version 
of software must be used until the VR100 is sent to 
VEMCO for upgrade. 
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5.4 GLOSSARY 
 
 
Blanking Interval:  The Blanking Interval is the length of time (in milliseconds) after an acoustic 

signal has been received in which the VR100 will ignore any subsequent signals.  This is to 
eliminate the reception of echoes by the receiver.   

 
Channel:  A channel in the VR100 is a group of configuration settings used to listen to VEMCO tags.  

For example, a channel can be configured to listen for continuous pingers that operate at 60 kHz.  
Another channel can be configured to listen for coded tags operating at 69 kHz. 

 
Coded Map:  A coded map is a group of four submaps operating on the same frequency.  There are 

currently three standard maps (see Table 5.2-1) for use with VEMCO’s coded tags.  Table 5.4-1 
is one of the standard coded maps. 

 
Table 5.4-1: A coded map with submaps. 

Code Type 
Map Name Code 

Space Submap Abbreviation # Pings 

A69-1008 A R256 6 
A69-1206 B R04K 7 
A69-1105 C S256 8 

MAP-110 

A69-1303 D R64K 8 
 
Coded Submap or Code Space:  A submap or Code Space is a portion of a coded map to which a 

coded tag type is assigned.  In Table 5.3-1, the line shaded in grey is the submap named B within 
the coded map named MAP-110.  When the VR100 receiver detects seven pings in a specific 
sequence, the receiver knows the pings have come from a 4K pinger and it can identify the 
pinger.  A submap can be customized to correspond with customized transmitters.  CAUTION:  If 
a customized submap is used with VEMCO’s standard coded tags, the VR100 can not identify the 
tags.  Use factory set submaps for standard coded tags and custom submaps for custom coded 
tags. 

 
Coded tags:  Coded tags transmit a series of acoustic pings to form an ID (identity) number recognized 

by the receiver.  The pings form a “ping train” that is usually followed by a fixed or random 
delay.  The type and length of the delay is set at the time the tag is ordered and can’t be changed 
once the tag is built.   

 
Continuous tags:  Continuous tags transmit the acoustic pings continuously, without long delays 

between transmissions.  Continuous tags are available with or without sensors. 
 
Map:  see Coded Map. 
 
Pinger:  A VEMCO tag that contains no sensors.  It can have either a coded or continuous transmission 

schedule. 
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Tag:  A VEMCO tag is an acoustic transmitter that is attached to a marine creature and transmits an 
acoustic signal.  The acoustic signal is received by a VEMCO receiver.  VEMCO tags can 
transmit either a coded or continuous signal, with or without sensor data.  After a tag is powered, 
it will continue to broadcast according to factory setup until powered down.   

 
Sensor transmitter:  A VEMCO tag that has at least one sensor.  The type of sensor is usually included 

in the transmitter’s name.  For example, a V16P has a pressure (depth) sensor and the V16T has a 
temperature sensor.  A sensor transmitter can also have either a coded or continuous transmission 
schedule.  

 
Submap:  see Coded Submap. 
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	1 INTRODUCTION
	1.1 ABOUT VEMCO

	VEMCO, a division of AMIRIX Systems Incorporated, is a leader in the design and manufacture of oceanographic research tools and systems since 1979. VEMCO's product line ranges from miniature acoustic transmitters and data loggers to large tracking, positioning, and monitoring systems. Data communication methods include acoustic telemetry, radio modem, and under-water modem.
	   
	Please contact us at:
	   VEMCO,
	   77 Chain Lake Drive,
	   Halifax, Nova Scotia,
	   Canada  B3S 1E1
	   Phone: 902-450-1700
	   Fax: 902-450-1704
	   Web:  www.vemco.com
	1.2 SYSTEM REVIEW

	The VR100 is a general-purpose ultrasonic, splash-resistant, receiver designed for manual tracking of aquatic animals from small boats or for recording laboratory data.  Its hardware architecture has been developed to support a wide range of applications and transmitter types.  It replaces the VR60 receiver.
	The VR100 software augments the VR100 receiver by having the following features: sensor tag management, custom coded map management, data retrieval, and comma separated variable file creation.  It can also store a copy of the receiver’s tag and map information on the computer, and that copy can be loaded to another VR100 or re-loaded to the current VR100 if necessary.
	 
	1.3 USING THIS MANUAL

	This manual, the VR100 Software Manual, contains the necessary information to use the VR100 software with the VR100 receiver to input sensor transmitter information and retrieve event data.  Event data can be data about a tag detection, GPS locations, and functions performed by the VR100.  The receiver can be used as a stand-alone unit (without software) and the necessary details are contained in the VR100 Operating manual.  Using the VR100 software with the receiver allows information to be entered and retrieved in a much faster manner.
	This manual is broken into major sections for easier use of the information found in the manual.  These sections, and a brief explanation, are listed in Table 1.3-1.
	Table 1.3-1:  Sections contained in this manual.
	Section
	Description
	Introduction
	Introduction to the VR100 and this manual.
	Applications
	Details on how to use the VR100 software with the receiver.
	Software
	Description of the software elements. 
	File Types
	Information on log files, CSV files, and resource files.
	Appendix
	Glossary and additional information.
	The manual refers to tags, pingers, and sensor transmitters.  The relationship these three terms have with each other is shown in the diagram below.  A tag can be either a pinger or a sensor transmitter.
	2  APPLICATIONS
	This section of the manual explains the VR100 software by tasks.  The Software section of the manual explains the software by section.
	2.1 QUICK SETUP

	Follow the steps listed below to setup the VR100 software and begin using it with the VR100 receiver.
	1. Connect VR100 to computer:
	a. Install the VR100 software on the computer, if not already installed (see section 5.1.2).
	b. Run the VR100 software.  This will open the Receiver Control and Management Interface window (see section 3.1).
	c. Connect the VR100 to the computer using the supplied USB cable (see the VR100 hardware manual for details). 
	d. Turn on the VR100.  If you are using Windows©2000, Windows©XP, or Windows©Vista, a “new hardware” wizard will appear the first time a VR100 is connected to the computer.  Follow the instructions in the wizard to add the VR100.
	2. Open a VR100 window:
	a. Verify that the desired receiver is highlighted in the Receiver Control and Management Interface window (see section 3.1).  If you can’t find the receiver in the list, then make sure the receiver is on and that the USB connector is properly connected.
	b. Click the “Open” button in the Receiver Control and Management Interface window to open the VR100 Receiver window for the selected receiver (see section 3.2).
	3. Set properties in software:  (only needs to be done on first use and if information has changed)
	a. Open the Options window (see section 3.2.3.2) in the Setting menu.
	b. Select the units to be used for the sensor information (see section 3.2.3.2).
	c. Select the data directory to be used for the raw events files (see section 3.2.3.2).
	4. Enter sensor transmitter information and custom coded maps (if needed):
	a. Open the Tag Manager window (see section 3.3).
	b. Setup the sensor transmitters being used with the receiver (see section 3.3.2.1.1).
	c. Setup any needed custom coded maps (see section 3.3.2.1.2).  Most customers will never need a custom coded map.  Custom coded maps are used with custom coded tags. 
	5. Transfer the sensor transmitter and custom coded map (if applicable) information to the VR100 receiver (see section 2.2.10).
	6. Turn off the VR100 receiver.
	7. Disconnect the VR100 receiver from the computer.
	8. Use the receiver in the field as explained in the VR100 Hardware manual.
	9. Repeat steps 1 and 2.
	10. Copy the collected data to the computer using Get All Data (see section 3.2.2.1).
	11. Save the data as a Comma Separated Variable file (.csv) for viewing in a spreadsheet program (see section 3.2.1.2).
	 
	2.2 HOW DO I …

	The “How Do I …” section of the manual lists the steps necessary to perform particular actions in the VR100 software.  The actions are listed alphabetically for easier referencing.  Use the Quick Setup (section 2.1) to use the VR100 software in a step-by-step manner. 
	2.2.1 Add a coded sensor transmitter

	Follow the steps listed below to enter a coded sensor transmitter in the VR100 software (see section 3.3.2.1.1).
	From the VR100 Receiver window (see section 3.2):
	1. Open the Tag Manager window by selecting Tag Manager in the Settings menu.
	2. Open a resource file, if desired (see section 2.2.9).
	3. Click the “Coded256Sensor” located in PC Managed Setup (left side of window).  The Add Coded 256 Sensor section will appear in the bottom left corner of the Tag Manager window.
	4. Enter the following information in the correct boxes.  The boxes are labelled and the information is found in the Transmitter Specification manual shipped with the sensor transmitter.
	a. Serial number
	b. Frequency in kilohertz (kHz)
	c. ID number
	d. Code Space – select the correct one from the pull-down list. 
	e. Sensor type – temperature or depth
	f. Slope
	g. Intercept
	5. Verify that the information was entered correctly.
	6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC Managed Setup section of the window.
	7. Transfer the tag setup to the VR100 receiver (see section 2.2.10).  
	2.2.2 Add a continuous one sensor transmitter

	Follow the steps listed below to enter a one sensor transmitter in the VR100 software (see section 3.3.2.1.1).
	From the VR100 Receiver window (see section 3.2):
	1. Open the Tag Manager window by selecting Tag Manager in the Settings menu.
	2. Open a resource file, if desired (see section 2.2.9).
	3. Click the “ContinuousOneSensor” located in PC Managed Setup (left side of window).  The Add Continuous Sensor section will appear in the bottom left corner of the Tag Manager window.
	4. Enter the following information in the correct boxes.  The boxes are labelled and the information is found in the Transmitter Specification manual shipped with the sensor transmitter.
	a. Serial number
	b. Frequency in kilohertz (kHz)
	c. Number of sensors – One
	d. Minimum period possible, in milliseconds (ms)
	e. Maximum period possible, in milliseconds (ms)
	f. Sensor type –  temperature or depth
	g. Slope
	h. Intercept
	5. Verify that the information was entered correctly.
	6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC Managed Setup section of the window.
	7. Transfer the tag setup to the VR100 receiver (see section 2.2.10).  
	2.2.3 Add a continuous two sensor transmitter

	Follow the steps listed below to enter a two sensor transmitter in the VR100 software (see section 3.3.2.1.1).
	From the VR100 Receiver window (see section 3.2):
	1. Open the Tag Manager window by selecting Tag Manager in the Settings menu.
	2. Open a resource file, if desired (see section 2.2.9).
	3. Click the “ContinuousTwoSensor” located in PC Managed Setup (left side of window).  The Add Continuous Sensor section will appear in the bottom left corner of the Tag Manager window.
	4. Enter the following information in the correct boxes.  The boxes are labelled and the information is found in the Transmitter Specification manual shipped with the sensor transmitter.
	a. Serial number
	b. Frequency in kilohertz (kHz)
	c. Number of sensors – Two
	d. Minimum period possible in milliseconds (ms)
	e. Maximum period possible in milliseconds (ms)
	f. In Sensor Details, click “Sensor One”
	g. Sensor type – usually temperature
	h. Slope
	i. Intercept
	j. In Sensor Details, click “Sensor Two”
	k. Sensor type – usually pressure
	l. Slope
	m. Intercept
	n. Sync – default value is 1150 ms
	5. Verify that the information was entered correctly.
	6. Click the “Update” button at the bottom of the window.  The tag will appear in the list in the PC Managed Setup section of the window.
	7. Transfer the tag setup to the VR100 receiver (see section 2.2.10).
	2.2.4 Create a comma delimited file from data 

	Create a comma delimited file from data by following the steps below (see section 3.2.1.3).
	1. Open the VR100 Receiver window (see section 3.1.1) for the receiver containing the data.
	2. Select Get All Data (see section 3.2.2.1) or Get Recent Data (see section 3.2.2.2), depending on how much data you want.  The data will load to the computer in less than four minutes.
	3. When prompted, select “Yes” to erase the receiver log data that was just copied to the computer or select “No” leave the log in the receiver.
	4. Select Export in the File menu (see section 3.2.1.3).
	5. Enter the desired file name in the “File name” box of the Export Current Log window and click “Save”.  The comma delimited file is created and located in the directory selected.
	The comma delimited file, or Comma Separated Variables file (see section 4.2), is now ready to be opened using a .csv supporting spreadsheet program of your choice.  Examples of spreadsheet programs that will support a .csv file are Excel and Quattro Pro.
	2.2.5 Create a comma delimitated file from a log file

	Create a comma delimited file from a log file by following the steps below (see section 3.2.1.2).
	1. Open a VR100 Receiver window (see section 3.1.1).  This can be any receiver window, including the Virtual receiver.
	2. Open the desired log file (see section 3.2.1.1).
	3. Select Export in the File menu (see section 3.2.1.3).
	4. Enter the desired file name in the “File name” box of the Export Current Log window and click “Save”.  The comma delimited file is created and located in the directory selected.
	The comma delimited file, or Comma Separated Variables file (see section 4.2), is now ready to be opened using a .csv supporting spreadsheet program of your choice.  Examples of spreadsheet programs that will support a .csv file are Excel and Quattro Pro.
	2.2.6 Edit a sensor transmitter

	Sensor transmitters that have already been entered can be edited.  Follow the steps below to edit an existing sensor transmitter (see section 3.3.2.1.1).
	1. Highlight the desired tag in the PC Managed Setup list (left side of Tag Manager window).  The information already entered about that tag is displayed in the bottom left corner of the window but is not accessible for editing.
	2. Click the “Edit” box in the bottom left corner of the window.
	3. Edit the tag information as needed.
	4. Click the Update button.
	 
	2.2.7 Load data from VR100

	Data that has been received and stored in the VR100 receiver can be loaded to the computer (see section 3.2.2).
	1. Open the VR100 Receiver window (see section 3.1.1) for the receiver containing the data.
	2. Select Get All Data (see section 3.2.2.1) or Get Recent Data (see section 3.2.2.2), depending on how much data you want.  The data will load to the computer in less than four minutes.
	3. When prompted, select “Yes” to erase the receiver log data that was just copied to the computer or select “No” leave the log in the receiver.
	2.2.8 Load the receiver’s setup to the computer

	The sensor tags and coded maps setup in the receiver are listed in the Receiver Setup half of the Tag Manager window (right side).  This list is updated automatically, but can be manually updated by following the steps listed below.
	1. Open the Tag Manager window (see section 3.3).
	2. Select Refresh in the Receiver Setup menu.
	2.2.9 Open a Resource file

	Open a resource file (see section 4.3) to retrieve the sensor tag setups and the custom coded map setups (if applicable).  A resource file is opened by following the steps below while in the VR100 Receiver window.
	1. Select Tag Manager in the Settings menu of the VR100 Receiver window (see section 3.2).
	2. Select Open in the File menu of the Tag Manager window (see section 3.3).
	3. Select the desired file in the Open window.  It may be necessary to move to a different directory, depending on where the resource file was saved.
	4. Click the “Open” button or double click the file name.  
	When a resource file is open, the sensor tag setups and custom coded map setups contained in that file are shown in the PC Managed Setup half (left side) of the Tag Manager window.
	2.2.10 Transfer the PC Managed Setup list to the Receiver Setup list

	The tag information entered in the PC Managed Setup half of the Tag Manager window (see section 3.3) must be transferred to the Receiver Setup half of the window to be downloaded to the VR100 receiver.  Follow the steps listed below to perform such a transfer.
	1. Open the Tag Manager window (see section 3.3).
	2. Enter the tag information by either entering it in the window (see section 3.3.2.1.1) or by opening a previously saved resource file (see section 3.3.1.2).
	3. Select the desired tag in the PC Managed Setup list (left half of window) by clicking it once with the mouse. TIP:  To select more than one tag at once, select the first tag then hold the Control key on the computer’s keyboard while you select the other tags with the mouse arrow.  Press the Shift key instead to select blocks of tags. 
	4. Click the right-pointing arrow located in the middle of the Tag Manager window.  The selected tag setup is transferred to the Receiver Setup list (right half of window) and automatically transferred to the VR100.
	2.2.11 View a comma delimited file

	Comma Separated Variable files (.csv), also known as Comma Delimited Files, can be viewed using any spreadsheet program that supports .csv files.  For example, Microsoft Excel and Corel Quattro Pro are both programs that support .csv files.
	2.2.12 View a log file

	Log files contain data received by the VR100 receiver (see section 4.1 for more information).  Log files can not be edited but can be viewed by following the steps listed below. 
	1. Open a VR100 Receiver window.  It doesn’t matter which receiver is selected, including the Virtual receiver.
	2. Select “Open” in the File menu of the VR100 Receiver window (see section 3.2.1.1).
	3. Select the log file from the list shown in the Open window.  The Open window will automatically list all log files located in the directory selected for Raw Event Logs (see section 3.2.3.2).
	The log file is displayed in the VR100 Receiver window, as shown in section 4.1.  Comments added to the “comments” column of the file are saved when the log file is saved as a comma delimited file (see section 3.2.1.2).  No changes can be made to the log file in .zlog format.
	3  SOFTWARE
	This section of the manual explains the VR100 software by section.  The Application section of the manual explains the software by tasks.  The software has three main sections: Receiver Control and Management Interface, VR100 Receiver, and Tag Manager.
	3.1 RECEIVER CONTROL AND MANAGEMENT INTERFACE

	VR100 receivers that are currently powered and connected to the VR100 software through a USB port are listed in the Receiver Control and Management Interface window, shown below.  More than one receiver can be connected to the software through the computer’s USB connection at the same time.  A USB hub increases the number of connections available for receivers.  The receiver that was most recently connected to the software is highlighted in blue in the VR100 list (see picture below).  
	The VR100 software can be used without a VR100 being connected to the computer by selecting the serial number “Virtual”.  This allows sensor transmitter information and coded map setups to be entered without the receiver being physically connected.  This allows sensor tag setups to be entered and saved in the software (see section 3.3) while the receiver is being used elsewhere.
	3.1.1 Open a VR100 Receiver window

	The quickest method to open a VR100 Receiver window (see section 3.2) is to double-click the desired receiver’s serial number in the list.  A receiver window can also be opened by highlighting the desired serial number and clicking the “Open” button at the bottom of the window.  
	3.2 VR100 RECEIVER

	When a receiver is opened from within the Receiver Control and Management Interface window (see section 3.1), it opens a VR100 Receiver window like the one shown below.  The receiver’s serial number is displayed in the top left corner to identify which receiver is associated with this window.  
	When more than one receiver is open, then more than one VR100 Receiver window is open.  One VR100 Receiver window is assigned to each receiver opened in the Receiver Control and Management Interface window.  Commands performed in the VR100 Receiver window affect only the receiver associated with that window.
	When data has been loaded from the receiver to the computer (see section 3.2.2), the number of system events and the number of detections in the loaded data are displayed the VR100 Receiver window.  The date and time of the latest detection or system event is also displayed.  
	Selecting the “Clear Table” button in the VR100 Receiver window will clear the log file displayed in the VR100 Receiver window without clearing the log file (see section 4.1 for more information on log files).  Clicking the “Abort” button will stop the data loading process (see section 3.2.2).
	3.2.1  File

	The File menu in the VR100 Receiver window is separate from the File menu in the Tag Manager window (see section 3.3.1).
	3.2.1.1 Open
	The Open command in the VR100 Receiver window allows a log file (see section 4.1) to be opened and viewed in the VR100 Receiver window.  Log files are saved when the Save As… command is used (see section 3.2.1.2).  A log file can be opened within any VR100 Receiver window, including the Virtual VR100 Receiver window.
	3.2.1.2 Save As…
	The data retrieved from the VR100 receiver can be saved as a ZLOG file (see section 4.1).  The Save As… feature opens the Save Current Log As window to allow the log file to be named.  The file is saved with the “.zlog” extension to distinguish it as a log file.
	3.2.1.3 Export
	The data retrieved from the VR100 receiver can be exported as a CSV file (see section 4.2).  The Export feature opens the Export Current Log window to allow the comma delimited file to be named.  The file is saved with the “.csv” extension to distinguish it as a Comma Separated Variables file.
	3.2.1.4 Exit
	This Exit command closes the VR100 Receiver window but not the Receiver Control and Management Interface window.  This allows another receiver to be selected in the Receiver Control and Management Interface window.
	3.2.2 Logs

	The Logs menu is used to load, or copy, the data stored on the VR100 receiver to a log file on the computer.  There are two options in loading data, to retrieve all the data stored in the VR100 (Get All Data) or to retrieve the data stored since the last upload (Get Recent Data). 
	When data is loaded to the computer, it’s actually copied to the computer.  The original copy is still in the receiver’s memory.  After the data is loaded to the computer, a prompt appears to ask if the data in the receiver’s memory, which was just copied to the computer, should be erased.  Selecting “Yes” will erase the retrieved data from the receiver’s memory.  Any new data that was recorded while the previous data was being loaded to the computer is still in the receiver’s memory.
	3.2.2.1 Get All Data
	The Get All Data command loads all data from the VR100 receiver to the computer.  This could take up to four minutes, depending on how much information is stored in the receiver’s memory.  The loaded data is stored as a log file (see section 4.1).
	 
	3.2.2.2 Get Recent Data
	The Get Recent Data command loads any new data stored in the VR100 receiver since the last command was given to load data.  If the Get All Data has never been given to this receiver, or if a different computer is being used since the last Get Recent Data command, then the computer will get all the stored data.  
	NOTE:  The method used to mark which data has been loaded to the computer is stored on the computer.  If the Get Recent Data command is sent from a different computer, then the computer doesn’t have a record of a previous upload and will load all the data from theVR100.
	3.2.2.3 Erase VR100 Log
	The Erase VR100 Log command will erase the event log in the VR100 receiver.  This is the same command that is seen after data is loaded from the receiver to the computer (see section 3.2.2).
	When the command is given, a verification screen is displayed to confirm that the receiver’s log should be erased.  The screen also indicates that some of the stored data may not have been loaded to the PC.  This is a reminder to upload the data from the VR100, if you want to keep the data, before erasing the memory.  
	To continue, click the “Yes, Erase the log” box and then the Erase button.  The Erase button isn’t enabled until the Yes box is checked. 
	When the memory is being erased, the Information window shown below is displayed on the screen to indicate the erase command is being executed.  It also indicates that some residual data may be retained in the receiver’s memory.
	Data is initially stored in a small, volatile memory buffer.  When the buffer is full, that data is moved to non-volatile long-term memory.  The Erase VR100 Log command erases all data in the long-term memory but not data in the buffer memory.  This feature allows the VR100 to continue to record new data during the erase process.  
	The data in the buffer, which is the most recent data, continues to be stored until the buffer is full and is then moved to the long-term memory.  This means that the data in the buffer will be loaded to the computer with the next upload and may appear as duplicated data.  This can be avoided by using the Get Recent Data command (see section 3.2.2.2).
	 
	3.2.3 Settings

	The Settings menu contains the sub-menus Tag Manager, Options, and Update VR100 Firmware.
	3.2.3.1 Tag Manager
	The Tag Manager window allows sensor tag setups to be created or edited, and transferred to VR100 receiver.  A group of sensor tags can be saved as a setup file and opened at a future time.  The Tag Manager window is explained in detail in section 3.3.
	Options…
	There are three options that are set in the Options window, shown here.  Two of these options are the units used for temperature and depth data.  These units are universal for the receiver.  For example, if °C is selected for temperature units, then all the temperature data received by the VR100 is in degrees Celsius (°C).  
	VEMCO’s standard units are °C and metres.  Other units can be used but the slope and intercept values must be converted to the new units and entered in the VR100.  The VR100 doesn’t automatically convert units.
	The Raw Event Logs directory is also selected in the Options window.  When data is loaded from the VR100 to the computer using the Logs menu (see section 3.2.2), raw log files (see section 4.1) are stored in the location selected here.
	3.2.3.3 Update VR100 Firmware…
	The firmware operating inside the VR100 can be updated without having to send the receiver to the factory.  The firmware is updated in three steps, which are listed and explained below.  To update the firmware, simply follow the directions of the computer screen.
	Step 1:  Current configuration.  The current configuration of the VR100 receiver is checked and displayed in the Update Firmware window on the computer screen.
	Step 2:  Select Image file.  Use the “Browse” button to identify the new firmware file on your computer.  The “Select Image File” window will automatically open the directory selected for Raw Event Logs in the Options window (see section 3.2.3.2) and only files with the correct extension will be shown.
	Step 3:  Test File.  The VR100 software tests the new firmware file before it is loaded to the VR100 receiver.  It will then send the file to the receiver.
	 
	3.2.4 Help

	The Help menu contains the sub-menus described below for your assistance.
	3.2.4.1 Content and Index
	The Content and Index command opens the Help Topics window to allow access to help information.  The Help Topics window contains the tabs Contents, Index, and Find which are explained below.
	 Contents
	To select a general topic for overall help, use the Contents feature.  Open a topic by double clicking on the book symbol next to the name, or on the name itself.  A list of sub-topics will appear to choose from. Double clicking on one of these sub-topics will open the help topics related to that general topic.
	 Index
	To select a specific topic, use the Index feature, which will display the complete list of topics in the help file.  To select a topic, either move through the list (using the arrow keys or the scroll bar) until the desired topic is highlighted, or type the name in the box at the top of the window.  As the name is entered, the list will reflect the letter being entered.  For example, if the letter “t” is entered, the list will alter so the “t” section is shown.  Once the topic is highlighted, either select Display at the bottom of the window, or double click on the topic name.
	 Find
	To search for a specific word within a topic use the Find feature.  A word list must be created if Find has not been previously used.  Simply follow the on-screen instructions to setup Find.  If Find is not desired, select Cancel.  A list of topics containing the desired word is listed in the third box from the top.  Select a topic and click the Display button at the bottom of the window.
	3.2.4.2 About VR100…
	Information about the VR100 associated with the selected VR100 Receiver window is shown in the Information window.  This information includes the serial number of the receiver and its hardware version, and firmware version.  If the VR100 was disconnected from the computer after the VR100 Receiver window was opened, then the About VR100… feature reports that the VR100 is disconnected.
	3.3  TAG MANAGER

	The Tag Manager window is the place to enter or edit sensor transmitter information.  It’s opened by selecting Tag Manager in the Settings menu of the VR100 Receiver window.  How to add or edit information is explained in section 3.3.2.  
	The left half of the Tag Manager window is called the PC Managed Setup and is used to enter and edit sensor tags.  The information seen in the PC Managed Setup list is the tag/map setup contained in the PC software.  The right half of the window is called the Receiver Setup and is the actual tag/map setup contained in the VR100 receiver.  When the Tag Manager window is opened, the software automatically requests the current setup from the receiver and displays it in the Receiver Setup half of the Tag Manager window. 
	The setup for tags can be passed between the PC and the receiver by using the arrow buttons in the middle of the window.  To copy a sensor transmitter from the PC Managed Setup list (on the left) to the Receiver Setup (on the right), select the desired tag by clicking it once with the mouse and then click the right pointing arrow in the middle of the window.  The tag now also appears on the right half of the window and has been automatically sent to the VR100.  
	TIP: To select more than one tag at once, select the first tag then hold the Control key on the computer’s keyboard while you select the other tags with the mouse arrow.  Press the Shift key instead to select blocks of tags.
	 
	3.3.1 File

	The File menu in the Tag Manager window is separate from the File menu in the VR100 Receiver window (see section 3.2.1) and contains the sub-menus described below.
	3.3.1.1 New
	The New command clears the PC Managed Setup (left half of window) to allow a new setup to be entered.  If changes had been made and not saved when the New command is given, a prompt appears asking if the changes are to be saved before the settings are cleared.
	3.3.1.2 Open
	The Open command in the Tag Manager window allows a previously saved resource file to be opened (see section 4.3 for more information on resource files).  Only the resource files located in the directory are displayed in the Open window to make file identification simpler.  
	3.3.1.3 Save
	The Save command allows changes made to a resource file to be saved.  What a resource file is named is determined by the user, but the extension must remain .xres or the file can’t be read by the software.
	3.3.1.4 Save As…
	The Save As… command allows the resource file name or location to be changed.  
	3.3.1.5 Exit
	This Exit command closes the Tag Manager window but won’t close the VR100 Receiver window or the Receiver Control and Management Interface window.  This is the same as clicking the X in the top right corner of the window.
	3.3.2 PC Setup

	The PC Setup menu allows sensor transmitter information to be setup.  It’s also used to combine separate resource files.
	3.3.2.1 Add
	The Add sub-menu allows a sensor tag to be added.  Adding a tag refers to entering a sensor transmitter’s information so the received data can be displayed in the correct units, which must be done for each sensor transmitter being used with the VR100.  
	 
	3.3.2.1.1 Add Tag
	A sensor transmitter’s information must be entered in the VR100 for the data to be displayed correctly.  A new sensor transmitter can be added by following the steps listed below.
	1. Select the tag type (coded 256 sensor, continuous one sensor, or continuous two sensor) by either using the PC Setup menu or by clicking the desired sensor type in the PC Managed Setup on the left half of the screen.  In either case, the bottom left corner of the Tag Manager window will display data entry boxes similar to the two samples shown below.  Initially the boxes are empty, as seen in the sample window on the left.  The sample window on the right has the information entered and is ready for the Update button to be clicked.
	2. Enter the information as identified in the window (see example above on the right).  The information needed is listed below by tag type.  The information can be found in the Transmitter Specification manual shipped with the sensor transmitters.
	a. Coded 256 Sensor:
	i. Serial number
	ii. Frequency in kilohertz (kHz)
	iii. ID number
	iv. Code Space – select from the pull-down list
	v. Sensor type – temperature or depth
	Slope
	vii. Intercept
	b. Continuous One Sensor:
	i. Serial number
	ii. Frequency in kilohertz (kHz)
	iii. Number of sensors – One
	iv. Minimum period possible, in milliseconds (ms)
	v. Maximum period possible, in milliseconds (ms)
	vi. Sensor type –  temperature or depth
	vii. Slope
	viii. Intercept
	 
	c. Continuous Two Sensor:
	i. Serial number
	ii. Frequency in kilohertz
	iii. Number of sensors (Two)
	iv. Minimum period possible in milliseconds
	v. Maximum period possible in milliseconds
	vi. In Sensor Details, click “Sensor One”
	vii. Sensor type (temperature)
	viii. Slope
	ix. Intercept
	x. In Sensor Details, click “Sensor Two”
	xi. Sensor type (pressure)
	xii. Slope
	xiii. Intercept
	xiv. Sync
	3. Click the Update button.  The tag is now added to the list shown in the PC Managed Setup half of the window (on left).
	NOTE:  The tag just setup has not yet been entered in the VR100 receiver.  It must be transferred to the Receiver Setup list (see section 2.2.10).
	Sensor transmitters that have already been entered can be edited.  Follow the steps below to edit an existing sensor transmitter.
	1. Highlight the desired tag in the PC Managed Setup list (left side of Tag Manager window).  The information already entered is displayed in the bottom left corner of the window but is not accessible for editing.
	2. Click the “Edit” box in the bottom left corner of the window to allow access to the information.
	3. Edit the tag information as needed and click the Update button.
	3.3.2.1.2 Add Map
	Maps are added by importing a .xres file.  Instructions for importing this file to your VR100 are found at http://www.vemco.com/pdf/vr100_codemap_instruction.pdf.
	 
	3.3.2.2 Import
	The import feature in the Tag Manager window allows multiple resource files to be combined into one file.  Follow the steps listed below to merge resource files.
	1. Open one of the files to be merged (see 3.3.1.2).
	2. Select Import from the PC Setup menu in the Tag Manager window.  The Import window will open.
	3. Select the second resource file to be merged and click the “Open” button.
	4. Repeat steps 2 and 3 until all the desired resource files are merged.
	5. If desired, save the merged file using the Save As… feature (see section 3.3.1.4)
	The merged file will not contain any duplication of information.  For example, if the sensor transmitter with the serial number 6739 is setup in two different resource files, it will only appear in the merged file once.
	3.3.3 Receiver Setup

	3.3.3.1 Refresh
	The Refresh command retrieves the current setup (sensor tags and maps) from the receiver and displays that setup in the right side of the Tag Manager window (called Receiver Setup).  The Refresh command is automatically executed each time the Tag Manager window is opened.
	4  FILE TYPES
	4.1 LOG FILES

	Log files are saved when the Save As… command is used (see section 3.2.1.2).  The Open command in the VR100 Receiver window allows a log file to be opened and viewed in the VR100 Receiver window.  A log file can be opened within any VR100 Receiver window, including the Virtual VR100 Receiver window, but can only be viewed in the VR100 software.  The log file has been specifically designed so it can only be opened in the VR100 software.
	The log files are usually saved using a standard file naming system and with the extension .zlog but a unique name can be assigned when the file is saved.  A sample of the standard file name is shown below.  The serial number in the file name is the serial number of the receiver the data was loaded from, and the date and time are when the log file was created on your computer.  
	The data displayed in the log file contains the following information for tag detections:  date, local time, channel, frequency (in kHz), tag type, ID (if coded), serial number (sensor tags only), data (see section 4.1.1), latitude, and longitude.  The signal strength and receiver gain levels can be viewed by “hovering” the mouse arrow over the cell in the Channel column.  Likewise, the slope(s) and interval(s) can been viewed by “hovering” the mouse over Data1 or Data2.  Comments can be typed in the Comments column of the log file to be saved in the Comma Separated Variable file (see section 4.2).
	Manual GPS readings are identified in the Type column of the log file as “GPS” and columns that don’t relate, such as frequency and data, are blank.
	Log files can be converted to Comma Separated Variable (.csv) files using the Export command in the VR100 Receiver window (see section 3.2.1.3).
	4.1.1 Data in Log files

	The sensor data is listed in either the “Data1” column or the “Data2” column of the log file.  If there is only one sensor in the sensor transmitter then data is only shown in the “Data1” column.  The unit for the data is given in the adjoining “Units” column.  The slope and intercept associated with this data can be viewed by holding the mouse arrow over the Data column.  The slope and intercept will appear for a few seconds in a small view box.
	Continuous pingers without a sensor display the period in the “Data1” column with the units listed as “ms” (milliseconds).
	4.2 COMMA SEPARATED VARIABLE FILES

	A Comma Separated Variable (CSV) file is a data file in which the variables are separated by commas.  This allows the file to be opened in a spreadsheet package that is CSV compatible, such as Excel or Quattro Pro.  These files are created using the Export command (see section 3.2.1.3).
	NOTE: Starting in version 1.6.3 of the VR100HS, detection times are output to the CSV file with three extra digits of precision.  These value are correctly read by Excel, however the default display formatting (mm:ss.0) is incorrect.  Change the formatting to "hh:mm:ss.000" to properly display these times.
	4.3 RESOURCE FILES

	Resource files, which have the extension .xres, contain the setup information for the sensor transmitters and custom coded maps that have been entered in the software.  These files must be manually saved (see section 3.3.1.3) as they aren’t automatically created by the software.  Resource files are extremely beneficial because they eliminate the need to manually re-enter the sensor transmitter information.  This saves time and allows the information to be loaded to other VR100 receivers very quickly and easily.
	 
	4.4 RAW FILES

	RAW files are automatically saved in the Raw Data Directory (see section 3.2.3.2) when data is loaded from the VR100 receiver.  These files, named VRDxxx.zraw where each x represents an integer, are not user-readable and are solely used by VEMCO for diagnostic or data recovery purposes.  The raw files can be deleted without affecting the operation of the VR100 if disk space is required on the computer but deletion is not necessary.  It’s suggested that the files are not erased until after data has been successfully recorded.
	5  APPENDICES
	5.1 SOFTWARE
	5.1.1 System Requirements


	The VR100 software is a Windows©98SE/2000/XP/Vista based software application that can be executed on any IBM compatible personal or mobile computer with the following configuration:
	Minimum Pentium II Processor, 366MHz 
	Minimum 4 MB Video RAM
	128 MB RAM
	Minimum SVGA Monitor 256 Colour
	CD drive for program installation
	One USB 1.1 or 2.0 connection (required for connection to VR100 receiver)
	5.1.2 Software Installation

	The VR100 software is a Windows©98SE/2000/XP/Vista application.  VEMCO assumes customer familiarity with Windows terminology. 
	To install the VR100 software, follow the steps listed below.
	1. Insert the install compact disk (CD) into the CD drive.
	2. From the Start menu in Windows, select Run.
	3. Type “X:\VR100HS_2.1.0_setup.exe” where the “X” represents the letter associated with your CD drive. 
	4. Follow the on-screen instructions.
	 
	5.2 CODED MAPS

	There are three default coded maps used with VEMCO coded tags.  These maps are listed in Table 5.2-1 with their Code Spaces and submaps.
	Map Name
	MAP-110
	240 ms
	A
	B
	C
	D
	MAP-210
	240 ms
	A
	B
	C
	D
	MAP-310
	240 ms
	A
	B
	C
	D
	5.3 TROUBLESHOOTING
	5.4 GLOSSARY

	Table 5.4-1: A coded map with submaps.
	Map Name
	Code Type
	Code Space
	Submap
	Abbreviation
	MAP-110
	A69-1008
	A
	R256
	6
	A69-1206
	B
	R04K
	7
	A69-1105
	C
	S256
	8
	A69-1303
	D
	R64K
	8
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